
Skanna & Redigera
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Skannerns knappar
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Starta 
skanning

Skannern måste vara påslagen 
men personligen använder jag 
inga andra knappar på den. Min 
skanning startas alltid via 
kommandon på datorn.

Jag skannar genom att lägga 
bilden vänd nedåt på glasrutan, 
går in på datorn och trycka på 
skanner-ikonen. 

Det ser ut som här till höger om 
jag använder min Epson skanner. 

Oftast kan man, som här till 

vänster, välja hur många 

inställningar man vill kunna 

göra i skannings-skrivbordet. 

<Helautomatiskt läge> ger ,  i 

mina ögon, för få möjligheter 

att styra skanningen. 

<Professionellt läge> ger 

omvänt onödigt många val

Det jag väljer är <Hemläge> 

eller <Kontorsläge>. 
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Börja alltid med 
förhandsgranskning
Initialt behöver man inte bry sig om inställningarna i fönstret 

mer än att man bör ange Bildtyp>Färg. Standardinställningarna 

brukar duga f.ö. men kan naturligtvis ändras

• Vill man åstadkomma en gråskale- eller svartvit bild så 

kan man göra det vid bildbehandlingen men det är 

omöjligt att skapa en färgbild av något som saknar färger

Skälet till att man vill förhandsgranska är att man vill säkra att 

hela den intressanta ytan ingår i den skannade bilden  
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Förhandsgranskning - Initiera 



6

Förhandsgranskning 
– Markera bilden 
Markera vad som ska skannas genom att 

1. Klicka med musen på bildens ena hörn och 

2. Med musknappen nedtryckt dra till det andra 

hörnet

3. Släpp sedan upp musknappen så kommer 

bilden at vara markerad
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Förhandsgranskning – Funktioner i fönstret 

I förhandsgranskningsfönstret 

så går det ex. att rotera bilden 

åt rätt håll.

Men, detaljprecisionen som 

krävs för att rotera bilden 3 ° åt 

vänster finns inte. Det får man 

göra i det redigeringsprogram 

som man normalt använder för 

den slutliga redigeringen av 

bilden
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Skanna –
Inställningar 
Efter förhandsgranskning väljer 

man <Skanna>. Men innan dess 

kan man göra inställningar för 

skanningen. 

• Att skanna i 300 punkter /tum är 

en normal inställning.

• Har man en liten bild så ger 1200 

punkter /tum bästa bildkvalitet. 

• Är bilden stor kanske man väljer 

96 punkter/tum för att spara 

diskutrymme. Då kommer 

bilden monterad i Word att bli 

exakt lika stor som originalet  
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Skanna – Styr lagring av skannad bild
Det spelar egentligen ingen roll var bilden lagras 

men DU MÅSTE VETA LAGRINGSPLATSEN! Styr 

bildlagringen till en plats du kan komma ihåg.

Skannern föreslår ett namn och format på filen. 

Här: img209.jpg. Det förslaget är oftast ok men vill 

man kan man naturligtvis istället lagra som pdf-fil

och använda ett annat prefix som vkort och ett 

annat startnummer 1 (vkort001.pdf) 
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Skanna – Styr lagring av skannad bild
Det spelar egentligen ingen roll var bilden lagras 

men DU MÅSTE VETA LAGRINGSPLATSEN! Styr 

bildlagringen till en plats du kan komma ihåg.

Skannern föreslår ett namn och format på filen. 

Här: img209.jpg. Det förslaget är oftast ok men vill 

man kan man naturligtvis istället lagra som pdf-fil

och använda ett annat prefix som vkort och ett 

annat startnummer 1 (vkort001.pdf) 
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Skanna – Resultatet
Den skannade bilden img209.jpg

har nu lagrats i katalogen Bilder



Bearbeta med Microsoft Foton
En bild kan bearbetas på en mängd olika sätt. Ett sätt är att bearbeta den i ett mottagande program 
som Word.

Vill man utföra mer komplicerade operationer eller ska infoga bilden i något annat än Word som ex. 
ett släktforskningsprogram, så bör istället ett bildredigeringsprogram användas. Adobe Photoshop är 
”kungen” men dyr. Gratisprogram som Microsoft Foton som ingår i Windows 10 kan det mesta som 
den vanlige användaren behöver.

Ytterligare ett alternativ är att ett skärmfångarprogram som Snagit nyttjas. Sådana fångar inte bara det 
som visas på skärmen utan kan utföra avancerad redigering. Den här presentationen är till största 
delen gjord med Snagit.
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Starta Microsoft Foton
Det finns flera sätt att starta 
programmet/appen Foton. Ett sätt är att 
klicka på ikonen för den i Starta-menyn 
eller aktivitetsfältet.

Då startas Foton i översiktsläget där du 
bl.a. kan administrera dina foton och 
söka fram dem efter olika kriterier där 
ansiktsigenkänning är det sist tillkomna.

Men det skulle krävas en separat 
utbildning för att gå igenom alla 
funktioner i det här programmet. 

Vi lade den skannade bilden i mappen 
<Bilder> och innehållet i den visas av 
Foton, så det går att gå vidare genom att 
klicka på bilden.  
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Starta istället genom klick på filen  
Om du ställt in att Foton ska vara 
det program/app som du normalt 
öppnar JPG-filer med, så kan du 
dubbelklicka på filikonen så öppnas 
Foton.

Annars kan du högerklicka på filen 
och, enligt bild, välja <Foton>.

TIPS! Om du istället gör valet <Välj 
en annan mapp> så kan du ställa in 
att Foton är det program/app som 
du öppnar vid dubbelklick på en 
JPG-fil.



15

Startfönstret i
Foton  
Programmet/appen Foton i Windows 10 
samlar foton från datorn, telefonen och 
andra enheter och ger klickbara länkar 
till dessa.

Om vi här klickar på vår skannade bild så 
ger Foton dig möjlighet att redigera den.
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Börja editera bild  

Bilden visas nu i redigeringsläge. 

Normalt klickar man då på de 
korslagda pennorna för att se menyn 
med alla redigeringsfunktionerna.
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Räta upp 

Knappen <Rotera> vänder 
bilden 90° åt höger. 

<Vänd> spegelvänder så att 
vänster sida blir höger.

Vill man justera en bild som 
blev lite sned vid skanningen 
så används verktyget <Räta 
upp>. För skjutreglaget åt 
höger eller vänster för att 
rotera bilden en grad åt 
gången  
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Beskär 

Vill man beskära en bild så 
används verktyget <Bredd-
höjd-förhållande>. Se till att 
funktionen har inställningen 
<Anpassat> om du vill skära 
bort olika mycket av bredd och 
höjd.

Klicka därefter någonstans mitt 
på respektive sida och dra 
kantlinjen åt höger, vänster, 
ned eller upp så att bildens 
storlek blir den önskade. Eller 
dra i hörnen och beskär 
samtidigt både på bredden 
och höjden. 
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Förstora bilden 

För en tidningssida eller motsvarande där detaljerna är viktiga så måste det hela 
tiden kontrolleras att inte ändring av ljushet, skärpa, kontrast etc försämrar 
läsbarheten av bilden. Därför bör bildvisningen förstoras så att det syns om 
bilden förändras positivt eller negativt.  
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Förbättra 
En av de mest användbara 
funktioner är 
Filter>Förbättra ditt foto.

OBS! Detta är en 
förändring vars effekt 
måste bevakas genom att 
bilden förstorats.

Klickar man i rutan så ställer sig linjen i mittläge vilket 
oftast är det som väljs. Genom att dra vita linjen till 
höger förbättra skärpa och kontrast i bilden och 
omvänt om det dras till vänster. 

Ett filter kan användas för att samtidigt tona bilden i 
någon färg. Oftast vill man inte det utan filtret 
<Original> används.
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Justeringar 

Under menyn <Justeringar> så kan 
bilden finjusteras.

Skannar man en boksida eller en 
tidning så blir kanterna ofta 
mörkare än mitten. <Vinjettering>
åtgärdar detta men har nackdelen 
att bildens kanter kan bli alltför vita 
och information försvinna.
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Retuschera 

Justeringar>Retuschera tar bort 
oönskade element i bilden.

Här klickas det på fingret i höger 
del av bilden och då försvinner 
området som valts. 

Tyvärr är funktionen inte så bra. 
Det kan bli svårt att här få bort 
hela tummen. Det 
rekommenderas att för redigering 
använda ”Paint 3D” som Foton är 
integrerad med.
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Paint 3D 

Paint 3D är egentligen en 
fristående applikation men den 
levereras med Windows 10 och 
det finns ett menyval i Foto 
som öppnar den med 
utgångspunkt från vald bild.

Paint 3D innehåller mängder av 
avancerade funktioner. 
Smartmarkering visas i det 
följande. Ett annat exempel är 
att man kan kopiera ett 
mönster från en bild och sedan 
spraya eller måla med den 
färgen.  



24

Paint 3D – Förstora och förminska 

Programmet är en vidareutveckling av 
Paint som alltid ingått i Windows. 

Men den här versionen innehåller 
många fler funktioner. De går måla, 
skapa böjda texter, göra 3D-figurer, etc. 

Med + kan bildvisningen förstoras och 
med – förminskas. Än bekvämare är det 
att använda rullningshjulet på musen.
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Paint 3D – Smartmarkering

1)Med Smartmarkering markeras ett område och <Nästa>.
2)Smartmarkering söker objekt i det området och markerar det med en grön kant. <Klar> trycks. 
3)När <Ta bort> klickas så fylls området med det som Smartmarkering identifierat som bakgrund.
4)Fingret har lyfts bort! Alternativt kunde ramens färg valts som anpassad bakgrund och sprayburken 
använts för att måla med den



GIMP för komprimering 
(och redigering)
Ett sätt att minska storleken på en bild är att krympa den. Men om bilden är av typ jpeg/jpg så kan 
bilden komprimeras med bibehållen storlek med en knappt märkbar kvalitetsförändring.

Har man använt Microsoft Foto för bildredigering så har den nackdelen att så fort man ändrar med 
den så ökar filstorleken om bilden sedan tidigare var komprimerad. För att komprimera bilden med 
bibehållen storlek och en oftast inte märkbar kvalitetsförsämring kan GIMPS användas. 

GNU Image Manipulation Program är gratis och kan hämtas från https://www.gimp.org/. Allt som går 
att göra i Microsoft Foto går göra här.  Och mycket, mycket mer. Verktyget påminner om Photoshop, 
utom att det är gratis, men kräver mer kunskap för att hantera än vad som behövs för Foto.

https://www.gimp.org/
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GIMP

Så här ser det ut om vi låter 
GIMPS öppna ”vår” 
tidningssida. 

OBS! Du kan öppna flera filer 
samtidigt.

Som synes finns det massor av 
verktyg att använda sig av.
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Exportera kompri-
merad jpeg

1)Välj Exportera som … 2)Ange det filnamn som den exporterade filen ska ha och 
3)Ändra kvaliteten så art filen får önskad storlek. Här krymper den från 1,7 MB till 916,2 kB men 
oftast går den komprimera mera utan kvalitetsförlust



Infoga och bearbeta i Word
Word är det vanligaste ordbehandlingsprogrammet. Den innehåller en hel del funktioner för att 
ta emot och redigera bilder. För många är de tillräckliga och det enklaste sättet att gå från 
skanning till en bild i ett dokument.
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Bilden ska följa med texten 

Se till att du i Arkiv>Alternativ>Avancerat har ställt in att bilder ska 
infogas ”I nivå med text” vilket innebär att bilden behandlas som en del 
av texten. 

Om du inte gör det så kommer bilden att ”flyta” på sidan och när du 
lägger in text före bilden så förskjuts den inte på rätt sätt
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Välj plats och bild för att infoga
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Bilden infogad
Pekar man på bilden så visar 
Word Format-menyn. 

Där går det ställa in bildstorlek 
och annat.
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Menyn Format>Korrigeringar

Ett av flera användbara verktyg är Format>Korrigeringar. Här har använts ett förval men det går använda 
vilken kombination av ljusstyrka, kontrast och skärpa som helst. Det går också att ändra färg på ett otal 
sätt. Andra exempel på verktyg är att det går rita och lägga text på en bild genom att använda menyn 
Format>Figurer 



OCR-skanna
När man skannar en bild så lagras den i form av färgpunkter, pixels. Med Optical Character Recognition så 
analyseras mönstret av färgpunkter och tolkas som text. Utifrån OCR-programmet får man alltså en 
redigeringsbar textfil som dessutom vanligtvis innehåller layout då OCR-tolken känner igen teckenstorlekar, fet 
text, etc.

Vanligtvis följer ett OCR-program med skannern men det finns också program som kan installeras gratis eller mot 
en avgift. Här demonstreras ett gratisprogram FreeOCR.

Senare i denna presentation visas hur man istället tolkar bilder m. h. a. Google Dokument. Den metoden är för 
det mesta att föredra och den går också att använda för bilder som hämtats från nätet och som innehåller  text.
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FreeOCR

FreeOCR är gratis och kan 
hämtas från 
http://www.paperfile.net

Se till att språket är 
inställt för svenska (swe) 
så att tolkningen inte 
utgår från engelska.

Inför varje ny skanning 
rensas fönstret där det 
tolkade resultatet visas.

http://www.paperfile.net/
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FreeOCR – Begär skanning

Vill man skanna in en bild 
för tolkning så väljer man 
<Scan>. Ska istället en 
redan skannad bild 
användas så väljs <Open>.

Vid skanning så visas ett 
dialogfönster där det finns 
möjlighet att välja en 
annan skanner av de som 
FreeOCR upptäckt. 
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FreeOCR –
Begär OCR-tolkning

I föregående steg så skannades bilden. Nu är det 
skannad och det begärs att den ska teckentolkas



38

FreeOCR – Kopiera texten
En sak som skiljer 
gratisprogram som denna från 
betalprogram är förmågan att 
hantera layout. 

Här är all text med samma 
teckensnitt, teckenstorlek och 
teckenstil och radbrytningarna 
följs slaviskt istället för att 
rader inom samma stycke förs 
samman. Indrag på raderna 
ignoreras.

Ett plus är att FreeOCR förstår 
att det finns spalter i det 
skannade.
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FreeOCR – Kopiera valda områden

Genom att hålla skift-
tangenten nedtryckt kan flera 
områden markeras och bara de 
OCR-tolkas.

Problemet är att om ett 
område till vänster och ett till 
höger markeras så kommer 
tolkningen att ske radvis och 
inte per markerat område. 



Google Dokument
Google Dokument är ett av tre program (de övriga är Kalkylark och Presentationer samt de två mindre 
programmen Formulär och Teckning) i molntjänsten Google Drive. I en molntjänst finns inte informationen lokalt i 
användarens dator, telefon eller surfplatta utan på en (här: Google-) serverdator på Internet. 

Fördelarna med molntjänster är många. Flera personer kan se och redigera ett dokument, dokumenten nås från 
alla datorer, surfplattor och mobiler som har internetuppkoppling, ingen information försvinner vid ex. ett 
datorhaveri, etc. Det går också att tillfälligtvis arbeta med dokumenten utan Internet-anslutning då sådana 
dokument synkroniseras med molnet så snart det finns en Internet-förbindelse.

Google Dokument är ett ordbehandlingsprogram precis som Word. Här nyttjas att om man ber den hantera en 
bild så kommer den parallellt att ge en tolkning av texten i bilden och den tolkningen kan kopieras. Google 
Dokument är en av de bästa programmen för OCR-tolkning.



Krav för att kunna använda Google 
Dokument
1. Uppkoppling till Internet. Men väl uppkopplad så går det att välja att köra i icke uppkopplat läge 

och när du åter är uppkopplad så synkroniseras det du gjort ”offline” med datat i molnet

2. Användaren måste ha ett Google-konto
• Det har alla som tar emot post via Gmail eller laddat ned appar från Google Play

• Övriga kan skapa ett Google-konto med e-post adress som kontonamn

3. Google Dokument kan användas med automatisk identifiering i följande miljöer:
• Windows med någon av de två senaste versionerna av webbläsaren Chrome

• Android-telefoner/plattor med Android-version 5.0 eller högre. Använd appen Google Drive

4. Google Dokument kan, efter det du identifierat dig, användas i följande miljöer:
• Windows med någon av de två senaste versionerna av följande webbläsare Firefox, Internet Explorer 

11, Microsoft Edge

• Mac med webbläsare Safari

• iPhone och iPad med iOS 11 eller senare



1. Starta Google Drive

• Google Dokument kan startas på flera sätt. 
Eftersom de dokument som ska bearbetas 
måste finnas i det webbutrymme som ditt 
konto ger tillgång till så är det lika bra att 
direkt starta Google Drive

• I webbläsaren https://drive.google.com så 
visas ditt lagringsutrymme i molnet
• I Google Drive har man 2019 gratis tillgång 

till 15 GB. Att tänka på är att en del av det 
utrymmet nyttjas av Gmail och Google Foto. 
Det går köpa till mer utrymme mot en 
månadskostnad

https://drive.google.com/


2. Initiera uppladdning av bild

• Ett alternativ är nu att öppna eller skapa en mapp 
för att lagra bilden

• Men här väljer vi att lagar bilden i roten på ditt 
drive-utrymme

1. Högerklicka på rubrikraden för din enhets lista med 
mappar och filer

2. Välj i menyn som då visas väljs <För över filer>



3. Ladda upp bilden
Välj nu vilken fil som ska laddas upp (här: 
Ersmarks äldsta historia.jpg)så sparas den på 
Google Drive



4. Välja att tolka bilden med Google Dokument

Klicka med höger musknapp på filen och 
välj i menyn som då visas Öppna med/ 
Google Dokument



5. Begär att få se den tolkning som Google 
Dokument gjort av texten i bilden

Nu visas den uppladdade filen i 
Google Dokument

Klicka på dokumentnamnet i 
menyn till vänster så öppnas 
den tolkning som Google 
Dokument gjort av texten i 
bilden  



6. Bildens text visas
Högst upp i högerkolumnen 

så visas nu bilden.

Under den visas texten som 

Google Dokument hittat i 

den.

Dokument tolkar vanligtvis 

texten korrekt. Men om den 

är skriven i spalter med tätt 

mellanrum så kan det bli 

nödvändigt att skanna en 

spalt åt gången. 



7. Kopiera texten till Word, en annan Google 
Dokument fil, ett släktforskarprogram, etc

Klicka i textens övre hörn och 

dra diagonalt nedåt så att texten 

markeras,

Håll därefter nere

medan du  trycker på 

så kopieras texten och du kan 

klistra in det (Ctrl + V) i ditt 

dokument. 
Observera att du kan använda Google Dokument för ordbehandling  som ett 

alternativ till Word. En OCR-tolkad text i Google Dokument kan klistras in i 

ett annat dokument i samma miljö. 


